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While Deltek has attempted to verify that the information in this document is accurate and
complete, some typographical or technical errors may exist. The recipient of this document is
solely responsible for all decisions relating to or use of the information provided herein.

The information contained in this publication is effective as of the publication date below and is
subject to change without notice.

This publication contains proprietary information that is protected by copyright. All rights are
reserved. No part of this document may be reproduced or transmitted in any form or by any
means, electronic or mechanical, or translated into another language, without the prior written
consent of Deltek, Inc.

This edition published March 2017.
© Deltek, Inc.

Deltek’s software is also protected by copyright law and constitutes valuable confidential and
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related
documentation, is provided for use only in accordance with the terms of the license agreement.
Unauthorized reproduction or distribution of the program or any portion thereof could result in
severe civil or criminal penalties.

All trademarks are the property of their respective owners.
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Overview

Overview

The Deltek Touch for Maconomy application is the best way for on-the-go Deltek Maconomy
users to not only submit and track time, expenses, and mileage, but also approve time, expenses,
vendor invoices, purchase orders, and even draft client invoices. It gives you access to several
dialog boxes related to Time Registration and Expenses (both Expense and Mileage) in
Maconomy. Even when you are away from the office, immediate mobile device access means
Deltek Touch keeps you informed and in control.

services. For more information, see the Deltek Touch for Maconomy Mscript and REST Web

‘ Not all functionality is available in all Maconomy versions and in MScript and REST Web
Services Comparison Guide.

This document provides instructions for the installation and configuration of the Deltek Touch for
Maconomy.

The official name of the application is Deltek Touch for Maconomy. This document only uses it
at first mention. The succeeding instances of the application name display Deltek Touch.

In addition, the application name in Apple App Store, Google Play, and Windows Store displays
Deltek Touch for Maconomy.

Supported Mobile Operating Systems

Deltek Touch for Maconomy supports mobile devices that run on the following operating systems:
= Apple iOS 9.0 and higher
= Android 4.4 and higher
=  Windows Phone 8.1 and higher

2.2 will still support Windows Phone. Starting September 1, 2017, however, the support for

’ Starting this release, we no longer support Android 4.1, 4.2, and 4.3. In addition, Deltek Touch
Windows Phone will end.

Touch 2.1 Technical Installation Guide 1
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Downloading Deltek Products using Deltek Software Manager

Downloading Deltek Products using Deltek
Software Manager

You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes,
and sub-releases. You can access DSM directly or through the Deltek Customer Care Connect
site.

When you access DSM directly, you will be prompted to log on before you can access the
application. If you access DSM from within the Deltek Customer Care site, you do not have to log
on since you are already logged into the Customer Care site.

Accessing DSM Directly

To access Deltek Software Manager directly, complete the following steps:
1. Launch Deltek Software Manager by taking one of the following actions:
=  Click here.
= On your desktop, click Start » All Programs » Deltek Software Manager.

2. Inthe Deltek Software Manager logon dialog box, enter your Deltek Customer Care User
ID and Password, and click Logon.

3. To select the folder where you want to download Deltek products, click Settings above
the right pane of Deltek Software Manager.

When you log on for the first time, Deltek Software Manager asks you to select a
default folder where Deltek products are to be downloaded.

4. Use the Settings dialog box to specify the folder where you want to download Deltek
products, and click OK.

‘ You can change this folder anytime in the Settings dialog box.

5. Inthe left pane of Deltek Software Manager, expand the Deltek product that you want to
download, if it is not already expanded.

If you clicked the link in step 1 to access DSM, the application automatically selects
Deltek Touch for Maconomy for you.

6. Select the product type that you want to download. Your options are Complete, HotFix,
and Sub-Release.

7. Inthe table, select the check box that corresponds to the Deltek product that you want to
download. The right pane displays a message stating that the product has been added to
the download queue.

To view the items in the download queue, click View Download Queue at the bottom
of the left pane.

Touch 2.1 Technical Installation Guide 2
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Downloading Deltek Products using Deltek Software Manager

8.

Click Download at the bottom of the left pane. Deltek Software Manager downloads the
product to the folder that you selected.

Accessing DSM from within the Customer Care Connect Site

To access Deltek Software Manager from within the Customer Care Connect site, complete
the following steps:

1.
2.
3.

In your Web browser, go to http://support.deltek.com.

Enter your Customer Care Connect Username and Password, and click Log In.
When the Customer Care Connect site displays, click the Product Downloads tab.
You are automatically logged into Deltek Software Manager.

To select the folder where you want to download Deltek products, click Settings above
the right pane of Deltek Software Manager.

When you log on for the first time, Deltek Software Manager asks you to select a
default folder where Deltek products are to be downloaded.

Use the Settings dialog box to specify the folder where you want to download Deltek
products, and click OK.

‘ You can change this folder anytime in the Settings dialog box.

In the left pane of Deltek Software Manager, expand the Deltek product that you want to
download, if it is not already expanded.

Select the product type that you want to download. Your options are Complete, HotFix,
and Sub-Release.

In the table, select the check box that corresponds to the Deltek product that you want to
download. The right pane displays a message stating that the product has been added to
the download queue.

of the left pane.

‘ To view the items in the download queue, click View Download Queue at the bottom

Click Download at the bottom of the left pane. Deltek Software Manager downloads the
product to the folder that you selected.

DSM Documentation and Troubleshooting

= To view the online help for Deltek Software Manager, click here.
= To view a tutorial on how to use Deltek Software Manager, click here.

= To view more information on troubleshooting Deltek Software Manager, click here.

The above troubleshooting link will only work if you are logged into Deltek Customer
Care Connect.

Touch 2.1 Technical Installation Guide
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Prerequisites

Prerequisites

Before you begin the installation of Deltek Touch for Maconomy, it is important to understand the
information in this section.

Technical Considerations
The following requirements must be met to run Deltek Touch for Maconomy:

= Deltek Touch for Maconomy can be run only on Maconomy X1 Service Pack 25 (or
higher), Maconomy 2.0 Service Pack 3 (or higher), Maconomy 2.1.1 (or higher),
Maconomy 2.2 (or higher), Maconomy 2.3 (or higher), and 2.4 LA.

= Deltek Touch for Maconomy cannot be installed on Sun (Solaris) or AlX server
platforms. As a workaround, it is possible to install Touch Time on Windows or RHEL
and then attach it to a Maconomy server running on Sun or AlX.

= Deltek Touch for Maconomy runs on IS or Apache for Windows and Apache for Red
Hat Enterprise Linux (RHEL).

Environment Prerequisites

Windows + IS = Deltek Touch requires 1IS be installed on a server that runs
Windows Server 2008, Windows Server 2008 R2, Windows
Server 2012 or Windows Server 2012 R2.

= Deltek Touch requires PHP 5.6.30 or higher to be installed
on lIS. The Touch Server installer installs the required
version of PHP.

Windows + Apache * You must install Apache on a server that runs Windows
Server 2012 or Windows Server 2012 R2.

= Deltek Touch requires PHP 5.6.30 or higher to be installed
on IIS. The Touch server installer installs the required
version of PHP.

= For Maconomy 2.1 and later using Apache on Windows,
you must use Apache 2.4 for both Deltek Touch and
Maconomy.

=  For Maconomy X1 and 2.0 using Apache on Windows, you
must have Deltek Touch installed on Apache 2.4 and
Maconomy on Apache 2.2.

Linux + Apache = Deltek Touch supports RHEL 5.x (starting with 5.6) and Red
Hat Enterprise Linux 6.x

= Deltek Touch only supports Apache 2.2 and Apache 2.4 on
Linux.

= On RHEL 5.x, Apache 2.2 is required.
= On RHEL 6.x, Apache 2.4 is required.

Touch 2.1 Technical Installation Guide 4
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Prerequisites

Environment Prerequisites

All Maconomy versions are certified on Apache

2.2. However, none of the Maconomy versions
are currently certified on Apache 2.4 on Linux.
Therefore, on RHEL 6.x, Deltek recommends
using different Apache installations for the
Touch Server (Apache 2.4) and Maconomy
(Apache 2.2).

= Deltek Touch requires PHP to be installed:

= On RHEL 5.x, Deltek Touch requires PHP 5.3.3 or
later.

= On RHEL 6.x, Deltek Touch requires PHP 5.6.25 or
later.

= QOur tests were conducted on the following setups:
= RHEL 5.6 + PHP 5.3.3 + Apache 2.2.3
= RHEL 6.0 + PHP 5.6.25 + Apache 2.4
= RHEL 6.5+ PHP 5.6.25 + Apache 2.4

= Deltek Touch is based on Maconomy dialogs. Therefore, Maconomy must be set up
correctly with regards to functionality and dialog access. Please see section below for
futher details.

= Deltek Touch for Maconomy setup requires the following add-ons:
= Maconomy Portal: Daily Time Sheets (110)
= Time on time (122)

= Deltek Touch for Maconomy supports Single Sign-On (login using domain credentials) using
Kerberos on both Apache and IIS Web server.

= Deltek Touch for Maconomy also supports SSO with the Windows Azure Active Directory

(WAAD).

=  Session cookies must be disabled when using Deltek Touch for Maconomy (in
MaconomyTouch.l).

In Maconomy 2.0 and later, by default, session cookies are disabled in
MaconomyTouch.l.

=  When using Secure Sockets Layer (SSL), you must have a certificate issued by a
trusted certificate authority. You must not use self-signed certificates. Wild card
certificates work if they come from a trusted certificate authority but are not
considered a best practice.

= Deltek Touch for Maconomy supports applications from Apple App Store, Google
Play, and Windows Store. If you are using an unsupported version of Maconomy
(compatibility mode), you may be able to use the native browser of your device to
enter your organization’s Deltek Touch for Maconomy URL.

Touch 2.1 Technical Installation Guide 5
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Prerequisites

The Deltek Touch for Maconomy URL has the format
https://<server>/deltektouch/maconomy/time, where <server> refers to the host name
of your Touch Server.

For security reasons and due to the SSL restriction that has been enforced by Apple
lately, Deltek Touch will no longer support HTTP links.

= |nthis release, Deltek Touch no longer supports HTTP for the online help
URL (see HELPDOCURL in configuration.ini).

= |n this release, all URLs that Deltek Touch uses must be HTTPS. This
includes the Touch Server URL, which you enter when you use the
application for the first time. It also includes the REST proxy URL.

Deltek recommends that you prepare for this transition beforehand. Otherwise, users
will not be able to use Deltek Touch application.

Compatibility Mode Definitions

Compatibility Mode Description

Fully Compatible You must be on Touch Android application, iOS application,
Windows Phone application, Web application, Touch Server, and
AP. All features and functions in the application are available to you.

Partially Compatible At least one of the components (Touch Server and/or API) is an
older version. Some features of the application are hidden and not
available to you.

Browser Compatible This ony applies to system administrators. At least one of the
components (Touch Server and/or API) is an older version. The
current application does not work with the Touch Server or API, but
you can still use the application through the mobile browser.

If you are using the browser version of Deltek Touch, not all
functionality will be available and you should expect considerably
slower performance of loading of the application when accessing
from browser.

Incompatible There are some combinations of APl and Touch Server that make it
impossible to even use the browser version to run the application.

In case of incompatibility, Deltek Touch displays two messages. The
first one informs you about the incompatibility that it detects.
Clicking OK on the incompatibility message displays the debug
message, which contains additional information about the
environment and is meant only for troubleshooting. After you click
OK on the debug message, you cannot use the native application
anymore.

Touch 2.1 Technical Installation Guide 6



-

y
Deltek kpovmore

Prerequisites

Compatibility Mode Description

You could also encounter the debug message when using

the browser version of Deltek Touch, but this is a very rare
situation. It happens if the network communication fails
during login because the application is retrieving the Touch
Server version from the configuration.ini file. If the Touch
Server version is not retrieved, the incompatible and debug
messages display.

The debug message displays when one of the following scenarios
occur:

=  The minimum Touch Server version defined in Deltek Touch is
greater than the version in the Deltek Touch Server. For
example:

= App Minimum Touch Server Version: 1.0.3.0
= Deltek Touch Server: 1.0.2.0

=  The maximum Touch Server version defined in Deltek Touch is
lower than the version set in Deltek Touch Server. For
example:

=  App Maximum Touch Server Version: 1.3.1.0
= Deltek Touch Server: 1.3.2.0

= |f there is no Touch Server version defined on the Deltek Touch
Server or Deltek Touch cannot retrieve the current Touch
Server version.

= |f there is no product version retrieved by the client-side.
= If the product version is not supported by the client-side.

= If the API version is not supported by the client-side

Touch 2.1 Technical Installation Guide 7
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Know more.
Do more.™

Feature Matrix

Touch Version

Weekly Time Registration ° ° ° °
Daily Time Registration ° ° ° °
Expense Registration ° ° ° °
Mileage Registration ° ° ° °
Approvals (Expense, Purchase Order, Vendor Invoice, ° ° ° °
Draft Invoice)
Rejected Time Flow ° ° ° °
Approval by Employee Type ° ° ° °
Possibility to Use Remarks on Favorites ° ° ° °
Layout Configuration (see Layout Configuration Guide ° ° ° °
for details)
Server-Side Configuration Options (see Installation ° ° ° °
Guide for details)
Unicode Support ° ° ° °
Support for RESTful Web Services (from 2.2.4 and 2.3 ° ° °
GA)
Auto-Completion of Domain Name ° ° ° °
Password Management: Change, Reset, Expired and ® ® @
Blocked Password
Expense Justification @ & @
Support for SSO with Microsoft Azure °
Registering Time in Days ® & @
Approving Time in Days ) ) °
Support for Login to Touch Using Maconomy ° ° ° °
Credentials in an SSO Environment
Purchase Order Fields Available in Timesheet and ® ()}
Touch 2.1 Technical Installation Guide 8
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Delte Know more.
Do more.™
Prerequisites
Touch Version 2.1
Expense Sheet for Subcontractor
Notifications for Rejected Expenses and Mileage ® ®

The @ symbol indicates that a feature is available for Touch installations using the RESTful API

only. The e symbol indicates that the feature is available for both MScript and REST.

Standard Maconomy Functionality Not Available in Deltek Touch

The following Maconomy standard features are not available in Deltek Touch:

Long text fields

Approval by substitute or super approver

Notifications for purchase orders, vendor invoices, and draft invoices
Monthly timesheets

Proxy time registration

Maconomy Configuration

Make sure that users have access to the following dialogs:

Time

This is valid only if you use the MScript Web service. If you use REST, you need only

TimeRegistration, DailyTimeRegistration,JobFavorite and Notes.

TimeRegistration
DailyTimeRegistration
DailyTimeSheets
DailyTimeSheetLines
JobFavorite

TimeSheets

Expense

ExpenseSheets
MileageSheets
DocumentArchives

DocumentRevisions

Approvals

ApprovalObjects
ExpenseSheetLines

TimeRegistrationDetails

Touch 2.1 Technical Installation Guide
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Know more.
Do more.™

Delte

=  PurchaseOrders
=  ShowVendorlnvoices

= InvoiceEditing

If use MScript in weekly or daily mode or if you use REST in daily mode, make sure that you
mark the “Use daily time sheets” system parameter during installation to register time on a day at

atime.
@ System Parameters - Maconomy Main Window (W 12.0 Demo) EIM
File Edit Menu Reports MNavigate Search Action Window Help
Ekldenu
JEEE System Parameters X]
Qp save g~ BX WK 4 b M
¥ System Parameter
Group Job Cost
Use daily time sheets
0
0.0
0.00
Here is another recommended system parameter:
. -
a System Parameters - Maconomy Main Window (W 12.0 Demo) E@Iﬂ
File Edit Menu Reports MNavigate Search Action Window Help
E* Menu
1 JEEE System Parameters x] i
Qr save @~ WX K 4 b M
C’é Remove filter 3 System Parameter(s) shown where Internal name is *registra™
¥ System Parameter
Group Job Cost
Allow Incomplete Time Registrations
0
0.0
0.00

This system parameter is not required, but if you mark it, the application allows you to add a line
with, for example, only a description. This task must be completed before submission.

A similar system parameter can be enabled for expenses. This supports the workflow for Quick

Capture.

Touch 2.1 Technical Installation Guide
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Know more.
Do more.™

Delte

Deltek Touch for Maconomy Infrastructure

The Deltek Touch for Maconomy infrastructure is composed of the application tier, middle tier,
and services tier. The Touch Server (middle tier) is used to optimize service delivery and
transform data when necessary. The Touch Server only communicates with the product service
layer and does not have access to the database.

The Touch Application (client tier) is a hybrid application created using HTML 5 and CSS 3 but

with the ability to access the native device capabilities.

Deltek Touch Technology Layers

Deltek Touch Technology Layers

CRM
Products

p

Time and Expense

Maconomy Products

Vision
Application Layer/

5 e Apache Cordova (Pheneeap)_g e to Native APIs
Mobile Application P =

Sencha Touch

HTML5 JavaScript

<

JSON

Backend/
Deltek Product
Services Layer

Deltek Core Product

Product Interface

\

Hybrid Client
Technologies

Deltek Core

Touch 2.1 Technical Installation Guide
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Services Tier

For Deltek Touch for Maconomy, the services tier corresponds to the Maconomy Web services.
The interaction between the Maconomy product and Touch Time (client + middle tier) is

illustrated below:

7
LAN

~

Firewall (optional)

N

2N

DMZ (optional) 0 S
erver

Firewall (optional)

} @
~

Internet

Deltek
Touch

Configuration.ini
REST Proxy Data

Proxy setup
(hostname, port)

Java Script ' Touch Server

Touch
{Web server)

Configuration.ini

MScript URL

Communication Description
Point
1 The Web server must contain the proper Web servicesfor

Deltek Touch for Maconomy. The Web service files must be
located in the /MaconomyMScript/Standard folder.

2 If this application should be reached from Internet, a port
has to be opened in the firewall. Typically, port 80 for HTTP
and 443 for HTTPS are used. Both loading of the
application and the Ajax communication use this opening in

the firewall.

3 When the application loads on the device, all
communications with the Maconomy Web server are done
via the Touch Server. The link to the Web service is set up
in the Touch Server |
(\maconomyshared\backend\configuration\configuratio

n.ini).

4 This is the JSON service (JSONWrapper). It is made in
Maconomy MScript and serves as a bridge between the
smartphone and Maconomy server. The setup and
environment will be explained in detail later.

5 The MScript service communicates directly with Web
Daemons on the Maconomy server. Typically, port 4101-
4110 is used, depending on how many databases and
installations the server serves. If the Web server is placed in
the DMZ zone, this communication could pass through the
firewall smoothly.

6 If the Web-serveris placed in a DMZ area, port 4101-4110
(depending on the number of applications installed on the
server) hasto be opened.

ESTful
Web
@ Service A

Maconomy
Web
server

(MScript
web service)

Coupling
Service

Container
Model
Java
Extension
Framework

Maconomy
Application
Server
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Deltek Touch for Maconomy Infrastructure

Supported Deployment Scenarios

The Deltek Touch for Maconomy application may be installed on another IIS or Apache server, or
as a separate directory on an existing Maconomy IIS or Apache Web server.

’ JSON N
over http/https °
S

. . Ajax/ISON

over http/htips

http/https
or tcpfip

Deltek Touch HTML S Hybrid Applications

B B @
Laptop - : Windows

Mobile applications now require HTTP/SSL,using a certificate from a recognized certificate
authority. Self-signed and SHA-1 encrypted certificates cannot be used.

Deltek Touch for Maconomy Security

Deltek Touch for Maconomy is a front-end application that integrates with Deltek’s traditional back
office applications, such as Maconomy. Deltek Touch only interacts with the Web services layer
of each of these applications, and no direct database interaction is performed. All data interaction
is performed in the Web services layer.

User Authentication Models

Deltek Touch does not introduce users and passwords, or define its own models. Instead, it uses
the existing product user provisioning, authentication, and authorization models.

Deltek Touch does introduce the PIN concept your convenience in application login. Once you log
in to the system successfully, you can store a PIN to simplify subsequent logins. When the PIN
feature is used, your credentials are stored on the device in encrypted form. The key to the
encryption is your PIN. The PIN is not stored on the device, and therefore you must memorize

it. When the PIN is entered, Deltek Touch tests to see if the credentials are successfully
decrypted. If they are, Touch passes the credentials to the backend system for authentication. If
the credentials do not decrypt after three attempts, the credentials are removed from the device
storage and you must again enter their full credentials. If you do not use a PIN, you must enter
your password each time you use the application.

The encryption is performed by the Stanford JavaScript Crypto Library (SJCL). SJCL uses
industry-standard AES algorithm at 128, 192, or 256 bits; the SHA256 hash function; the HMAC
authentication code; the PBKDF2 password strengthener; and the CCM and OCB authenticated-
encryption modes.

Touch 2.1 Technical Installation Guide 13
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Deltek Touch for Maconomy Infrastructure

‘ For more information, see http://bitwiseshiftleft.github.io/sjcl/.

You log in to Deltek Touch using your domain credentials (this requires that both Maconomy and
Deltek Touch are set up to use Single Sign-On via Kerberos) or using your Maconomy
credentials.

Single Sign-On Via Kerberos

The first time you log in to Touch, you enter your network user name, password, and domain.
Once successfully authenticated, you must set a PIN. Once you have set your PIN, you can log
in using only this PIN. To protect your login credentials in transit, Deltek recommends that the
Touch Web Server be configured to use HTTPS (instead of HTTP). The domain credentials are
sent from your mobile device to the Maconomy Web server via the Touch Server.

Using HTTPS/TLS encrypts your network traffic, making it very difficult to sniff the credentials as
they are passed to the Web server. On the Maconomy Web server, the domain credentials are
used only to obtain a Kerberos ticket for the Maconomy service on your behalf. Your domain
credentials are not stored on the Web server. As soon as this ticket is obtained, the credentials
are deleted.

Single Sign-On Via Azure

The first time you log on to Deltek Touch, you enter your Azure credentials. The Azure user name
is entered in Deltek Touch, but the password is entered in the native Windows Azure login
screen. Once successfully authenticated, you must nominate a PIN. Once you have set your PIN,
you can log on using only this PIN.

Your Azure credentials are not stored on the Touch Server or the Maconomy server. Instead, the
token returned by Azure is sent to the Maconomy server to perfrom the Maconomy
authentication. To protect the Azure token in transit, Deltek recommends that the Touch Web
Server as well as the REST proxy server be configured to use HTTPS (instead of HTTP).

Sign on Using Maconomy Credentials

If Touch is not set up with Single Sign-On, you log on using your Maconomy credentials (user
name and password). When logging on the first time using your Maconomy credentials, you have
the option to set a PIN. Once you have set the PIN, you can use it for future logins. You can reset
the PIN at any time or you can also switch back to using your Maconomy credentials instead of
the PIN.

On the Maconomy Web server, the credentials are used for logging on to the Maconomy system.
In a successful login, a token is added to the session and the session ID is sent back to your
mobile device. From that point forward, any communication between the mobile device and
Maconomy Web server includes the session ID for authentication. This means that the
Maconomy credentials are sent from the mobile device to the Maconomy Web server only for the
login. The password is not stored and cannot be reverse-engineered on the Maconomy Web
server.
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Deltek Touch for Maconomy Infrastructure

Security Assessments

Deltek strives to deliver a highly secure applications. Therefore, an independent security
assessor, GuidePoint Security, has performed a Mobile Application Security Assessment with the
intent of evaluating the security posture of Deltek’s Mobile Touch suite of applications. The
security baselines for the scope of the audit were the OWASP Top 10 Web Application
vulnerabilities and the OWASP Top 10 Mobile vulnerabilities.

‘ For more information, see https://www.owasp.org/index.php/Top10#OWASP Top 10 for 2013.
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Microsoft IIS Web Server Configuration on Windows Server 2008

Microsoft IS Web Server Configuration on
Windows Server 2008

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on
Windows Server 2008. The Deltek Touch for Maconomy installer checks if Microsoft Internet
Information Services (1IS) is already installed before proceeding with the installation. The
installation terminates if 1IS is not yet installed.

To configure Microsoft IIS Web server on Windows Server 2008, complete the following

steps:
1.
2.
3.

10.

11.

Click Windows » Start » Administrative Tools » Server Manager.
Expand the Roles tree on the left pane, and click Web Server (IIS).

When the Web Server (1IS) screen displays, click Add Role Services in the bottom right
pane.

On the Select Role Services screen, perform the following actions:

= Click Web Server » Application Development, and select ISAPI Extensions and
CGl.

= Click Web Server » Management Tools, and select IS Management Scripts and
Tools.

= Click Web Server » Management Tools » IS 6 Management Compatibility, and
select IIS 6 Metabase Compatibility.

Click Next, and then click Install.
Click Close when the installation completes.

Expand the Web Server (11S) tree on the left pane, and click Internet Information Services
(I1S) Manager.

On the Internet Information Services (IIS) Manager screen, expand the IS computer
name icon on the left pane of the Internet Information Services (11S) Manager window.

Right-click the IS computer name icon, and select Stop.

Right-click the IS computer name icon on the left pane of the Internet Information
Services (IIS) Manager window, and select Start.

Close the Services Manager window.
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Microsoft IIS Web Server Configuration on Windows 2012 Server

Microsoft IIS Web Server Configuration on
Windows 2012 Server

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on
Windows Server 2012. The Deltek Touch for Maconomy installer checks if Microsoft Internet
Information Services (1IS) is already installed before proceeding with the installation. The
installation terminates if 1IS is not yet installed.

Deltek Touch for Maconomy requires Anonymous Authentication and does not support Basic
Authentication.

To configure Microsoft IIS Web server on Windows 2012 Server, complete the following
steps:

1. From the desktop view, display the Charm Bar. To do this, take one of the following
actions:

= Move the cursor to the bottom right corner of the screen, which causes the bar to
display on the right.

= On your keyboard, press the Windows key + C.

For more information about Charm Bar, see the following
link: http://windows.about.com/od/windowsforbeginners/a/Get-To-Know-The-New-

Windows-8-Start-Menu.htm.

Click Start » Administrative Tools » Server Manager.
On the left pane, click IIS.
On the right pane, scroll down to the see the ROLES and FEATURES section.

From the Tasks drop-down list, select Add Roles and Features. The Add Roles and
Feature Wizard displays.

Click Next.

o > 0N

o

7. Select the Role-based or feature-based installation option.

8. On the Select Destination Server page, verify if the Select a server from the server
pool option is selected. Click Next.

9. On the Select server roles page, expand Web Server (1IS) » Web Server » Application
Development, select CGIl and ISAPI extensions

10. On the Select server roles page, expand Web Server (1IS) » Web Server »
Management Tools, and then select IIS Management Scripts and Tools.

11. Click on Next. The Select features page displays.
12. Click Next, and then click Install.
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Deltek Touch for Maconomy Installation on
Windows Server

Before you proceed, make sure that you downloaded the server component from Deltek Software
Manager (DSM). Once the server part is installed, download the application from Google Play
Store or Apple App Store and install it in your device.

For more information about DSM, see Downloading Deltek Products using Deltek Software
Manager in this document.

To install the Deltek Touch application, complete the following steps:

1. Run DeltekTouchMaconomy?21l.exe to launch the installation program.

Deltek recommends selecting the Run as Administrator option when launching the
installation executables even if you (as the logged-on user) has local administrative
rights. You can access this option by right-clicking the installation executable file name
in Windows Explorer and then clicking Run as Administrator on the shortcut menu.

‘ Taking into consideration the enhanced security in Windows Server 2008 and 2012,

2. Onthe Welcome to the Deltek Touch Maconomy 2.1 Installation Wizard page, click Next.

3. Onthe License Agreement page, review the license agreement, select the | accept the
terms of the license agreement option, and click Next.

4. Onthe Select Web Server Type page, select one of the following options, and click Next:
= Apache Web Server
= IS

5. On the Maconomy Product Information page, provide the necessary information, and
click Next:

= Maconomy MScript URL — Enter the full Maconomy Touch URL (for example,
http://eu100242:20003/cgibin/Maconomy/MaconomyTouch.wl6de.en_US.exe).

= Charset —You can only edit this field if you are performing a new install. Select a
character set from the drop-down list.

need to change the character set manually in configuration.ini from 1SO-8859-1 to UTF-

‘ The default character set is ISO-8859-1. If you are on Maconomy 2.1.1 (or higher) , you
8.

= Maconomy 2.2.4 or later — Select this option if your Maconomy core is 2.2.4 or later.

If this option is not marked, you will not be able to set up Touch to use the RESTful
web services. If your Maconomy version is 2.2.4 / 2.3 GA or later, then is very important

to mark this option, to be able to set up REST for Touch.

6. Take one of the following actions, depending on the selected Web server type in step 4
and the selection you make for the Maconomy 2.2.4 or later option in step 5:

Apache Web Server

If you selected Apache Web Server but do | If you selected IIS in step 4 but do not
not select Maconomy 2.2.4 or later in step | select Maconomy 2.2.4 or later in step 5,
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Apache Web Server

5, the Choose Apache Installation Directory
page displays. Proceed to step 7.

| IS

the Choose Application Install Directory
page displays. Proceed to step 9.

If you selected Apache Web Server in
step 4 and Maconomy 2.2.4 or later in
step 5, the REST Proxy Data page
displays. Provide the necessary
information, and click Next.

= Host Name — Enter the host name of
the REST endpoint machine (for
example, touch.<company
name>.com).

= Port Number — Enter the port number
if there is a specific port connecting to
REST endpoint.

= Language — Enter a specific
Language to use in Maconomy core
(for example, en-US).

= Database — Enter the short name of
the Maconomy core.

Proceed to step 8.

If you selected Apache Web Server in
step 4 and Maconomy 2.2.4 or later in
step 5, the REST Proxy Data page
displays. Provide the necessary
information, and click Next.

= Host Name — Enter the host name of
the REST endpoint machine (for
example, touch.<company
name>.com).

=  Port Number — Enter the port number
if there is a specific port connecting to
REST endpoint.

= Language — Enter a specific
Language to use in Maconomy core
(for example, en-US).

= Proxy Pass Client Code — Enter the
connection for Multi-tenancy setup.

= Database — Enter the short name of
the Maconomy core.

= |IS Site Name — Enter the IIS site
name. If the IIS site is set to Default
Web Site, this field should be blank.

Proceed to step 8.

7. On the Choose Apache Installation Directory page, verify if the default location for the

Apache Web software is correct, and click Next. Otherwise, click Browse to navigate to
the installation folder, and click Next. Proceed to step 11.

‘ The default folder is C:\Program Files (x86)\Apache on a 64-bit machine or C:\Program

Files\Apache on a 32-bit machine.
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If you selected Apache Web Server, the files are installed onto
<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>. If
multiple instances of Deltek Touch for Maconomy are installed (using the same
Maconomy language) on Apache Web server, the folder name will be incremented.

For example:

1st instance -
<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>

2nd instance -
<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomyLanguage>_1

3rd instance -
<INSTALL_DIR>\htdocs\DeltekTouch\Maconomy\Time_<MaconomylLanguage>_2

You can rename the “Time_<MaconomylLanguage>_<number>" folder after the install;
the updated folder name will reflect on the URL.

8. Onthe REST Module Setup, select the setup for REST Module and click Next:

= Use for Time — Select this option to use RESTful Web service for time registration. If
not selected, it uses the MScript Web service.

10.

11.

= Use for Expense — Select this option to use RESTful Web service for expense and
mileage registration. If not selected, it uses the MScript Web service.

By default, the two options are not selected

On the Choose Application Install Directory page, verify if the default location for the
Deltek Touch software is correct, and click Next. Otherwise, click Browse to havigate to
the installation folder, and click Next. Continue with the next page (10).

If you selected IIS, the default folder is C:\Program Files (x86)\Deltek\Touch on 64-bit
machine or else C:\Program Files\Deltek\Touch on 32-bit machine. You can run the
installer multiple times to install several instances of Deltek Touch for Maconomy. Each
instance, however, requires a new virtual directory pointing to a different physical
location (Install Directory).

On the IIS Website Information page, select or enter the default Web site, and click Next.

Select the Please check the box if the website is configured for SLL check box to
use the HTTPS protocol when transmitting data over the Internet.

If no site displays in the drop-down list, make sure you completed the steps from
Microsoft IS Web Server configuration on Windows Server from the previous section.

On the Pre-Installation Summary page, review the installation details that you provided.
The set of information details on the Pre-Installation Summary page varies, depending on
the Web server type that you selected in step 4.

= |f you want to change any settings, click Back, and make the necessary updates.

= If you are done, click Install to begin the installation.

If there are errors, the DeltekTouchlnstall.log file displays. For Apache Web Server,
the log file is saved in the C:\Program Files\Apache folder. For IIS, the log file is saved
in the Application Install folder.

You can test the REST Container URL specified on the screen.

12. When the installation is done, on the InstallShield Wizard Complete page, click Finish.
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If you selected Apache Web Server, restart the Apache Windows service for the changes to
take effect.

=  For Apache, the default URL is
https://<server>:<port>/deltektouch/maconomy/time/, where <server> refers to the
host name of your Deltek Touch Server and <port> refers to the port number that the
Maconomy server uses to listen for requests.

= For IS, the default URL is usually https://<server>/deltektouch/maconomy/time/.
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Deltek Touch for Maconomy Installation on Linux
Server

Perform this procedure if you are going to install the Deltek Touch for Maconomy application on
Linux server.

A prerequisite for Deltek Touch is PHP. On RHEL 5.x, Deltek Touch has been tested with PHP
5.3.3. On RHEL 6.x, Deltek Touch used PHP 5.6.5.

Prerequisite

Before you proceed with the PHP upgrade, make sure that you alter the channel subscription and
select the optional repository.

For more information, see http://snippets.roozbehk.com/post/35750940300/php-mbstring-
missing-on-red-hat-enterprise-linux-6.

RHEL 5.6
The recent version is PHP 5.3.3 with Apache 2.2.3.
In the terminal window, run the following commands:

1. yum install php533
2. yum install php53-mbstring.x86 64

RHEL 6.0 and 6.5
The recent version is PHP 5.6.25 with Apache 2.4.

For the Apache 2.4 installation, complete the following steps:

configurations would overlap. In addition, you should disable automatic startup of Apache 2.2 if

‘ If Apache 2.2 is installed, you should stop the original httpd (Apache 2.2) because the
enabled).

1. Download the file rhscl-httpd24-epel-6-x86_64-1-2.noarch from the following link:
https://www.softwarecollections.org/repos/rhscl/httpd24/epel-6-x86_64/noarch/
2. From WinSCP, copy the file from Windows to RHEL /var/tmp.

3. Inthe terminal window, run the following commands:
a. rpm -i rhscl-httpd24-epel-6-x86_ 64-1-2.noarch.rpm
b. yum install httpd24
C. ps —ef | grep httpd

d. /etc/init.d/httpd24-httpd start
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For the PHP 5.6.25 installation/upgrade, complete the following steps:

At this point, you may get a prompt stating that there are one or more dependencies missing
from the system that should also be installed. You perform the installation manually because this
is an SCL package and yum cannot install the dependencies automatically.

In the terminal window, run the following commands:

1. yum list | grep rh-php56*

2. yum update rh-php56-php.x86 64

3.

/etc/init.d/httpd24-httpd restart

If Deltek Touch is still not working, perform the following actions after you complete any of the
installation above, depending on your RHEL version.

1. Execute the command sudo setsebool -P httpd_can_network _connect on.
2. Launch the Dletek Touch Web site.

Before you perform the installation procedure, make sure that you rename DeltekTouch folder
found on the specified location for Apache Web Root inside installDeltekTouch.sh file to
DeltekTouchPrev. By default, the location is set to /var/www/html.

cd <location specified in Apache Web Root parameter>
mv DeltekTouch DeltekTouchPrev

The file name where the location of the Web root parameter is set is as follows:
/..I./Linux/installDeltekTouch.sh.

To install the application, complete the following steps:

1.

Copy DeltekTouchMaconomyLinux21.tar and save it to a temporary folder on a Linux
machine.

Extract the TAR file using tar -xvf DeltekTouchMaconomyLinux21l.tar. The files are
extracted to the Linux sub-directory.

Update the following properties in install DeltekTouch.sh within the section enclosed in

APACHE_PORT
SVR_NAME
CHARSET
PHP_INSTALLED
APACHE_WEB_ROOT
INSTALL_DIRECTORY
URLDomain
CLIENTURL
MACONOMY_224UP

If the current Maconomy core is 2.2.4 or later, provide details for the following entries:

REST_HOST_NAME
REST_PORT_NUMBER
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= REST_LANGUAGE

= REST_DATABASE

= USERESTFORTIME

= USERESTFOREXPENSE

4. Run the following command from the terminal to install the software:

./installDeltekTouch.sh

’ Make sure you run the command as root user.

5. After the installation, restart the Apache Web server for the changes to take effect.
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Deltek Touch for Maconomy Setup

This section contains information on how to set up Deltek Touch for Maconomy, corresponding
service pack, hot fix, Web services, and related configuration settings.

Maconomy MScript Web Services

This section is mandatory. It includes the installation of the MScript Web services.

Even if you prefer to use the RESTful Web services, you still need to have the MScript Web
services installed.

MConfig

Deltek recommends that you user the latest MConfig version, which you can downloaded from
DSM, under the release corresponding to your Maconomy version. Your MConfig version cannot
be older than 8.8.

Maconomy Service Pack

= |If you are using Maconomy X1 Service Pack 24 or lower, you must upgrade to Service Pack
25 or later, which you can download from DSM.

@ If you are using Maconomy X1 Service Pack 25, you do not have to do anything in this
’ step.

= |f you are using Maconomy 2.0 Service Pack 2 or lower, you must upgrade to Service Pack 3
or higher, which you can download from DSM.

If you are using Maconomy 2.0 Service Pack 3 or higher, you do not have to do
anything in this step.

= |f you are using Maconomy 2.1 (GA) or lower, you must upgrade to 2.1.1 or higher, which you
can download from DSM.

‘ If you are using Maconomy 2.1.1 or higher, you do not have to do anything in this step.

= |f you are using Maconomy 2.2 LA, you must upgrade to 2.2 GA or higher, which you can
download from DSM.

If you are using Maconomy 2.2 (GA) or higher, you do not have to do anything in this
‘ step.

Maconomy Hot Fix

You need to install the Hot Fix containing the latest Maconomy Web services for Touch.
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The hot fix contains only the files needed for Touch Time, as well as all dictionaries (similarly to
APU). During the FPU installation, the Coupling Service restarts due to applying the dictionaries.

If you are using Maconomy X1, you need to install
fpu.w1200.touchapi_2_1_0_0.tgz, which you can download from DSM, under the
release corresponding to your Maconomy version.

‘ You can only install this hot fix on Maconomy X1 Service Pack 25-29.

If you are using Maconomy 2.0, you need to install
fpu.w1500.touchapi_2 1 0_0.tgz, which you can download from under the release
corresponding to your Maconomy version.

‘ You can only install this hot fix on Maconomy 2.0 Service Pack 3-9.

If you are using Maconomy 2.1, you need to install
fpu.w1600.touchapi_2_1_0_0.tgz, which you can download from under the release
corresponding to your Maconomy version.

You can only install this hot fix on Maconomy 2.1.1, 2.1.1 Cumulative Updates 1, 2.1.4,
2.1.5,2.1.6,2.1.7,and 2.1.8.

If you are using Maconomy 2.2, you need to install
fpu.w1700.touchapi_2_1_0_0.tgz, which you can download from under the release
corresponding to your Maconomy version.

‘ You can only install this hot fix on Maconomy 2.2, 2.2.1, 2.2.2, 2.2.3, and 2.2.4.

If you are using Maconomy 2.3, you need to install
fpu.w1900.touchapi_2_1 0_0.tgz, which you can download from under the release
corresponding to your Maconomy version.

‘ You can only install this hot fix on Maconomy 2.3 LA, and 2.3 GA.

If you are using Maconomy 2.4, you need to install
fpu.w2000.touchapi_2_1_0_0.tgz, which you can download from under the release
corresponding to your Maconomy version.

You can only install this hot fix on Maconomy 2.4 LA.
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The hot fix should be installed the same way as an application patch using MConfig:

¥ MConfig 8.11 - the Maconomy Configurator H=] B3
Application instance w_17_0.sp100.std configuration

Application version 'M aconomy

Database environment I'E-DL sef nstance (local) in c:\program files\microsoft sql server\100%tools ,1[

¥ Unicode data

Application home ID'\m aconomy'y 0.sp100.std

Port humber IMM

Application patch ISelvice pack apu.w1700.p100a (installed) _V_j
I™ Skip import of sereen and print layouts in patch installation

™ Skip index updating (only make SOL update file)

Enterprise language Iem_UE _'J
Server user language | en_US ll
Prints format [#«d =~
I Create documentation database wi70doc

TPU |tpuNT=86.17_0.p100 x|
Portal TPU |Same as TPU |
Shorthames w17p100 (W 17 (SOLServer) - SP p100 - Demo) ﬂl

Add I
Delete |

Installation number |5~1 -17-1000-75-3-7 3ffff-14ef3f-7fbfd3-{97ff3-fifbif-f1--b562992a-f7 7bd566-5d128015-dz

Registiation number  [723211915

Control number l

Load dependencies from file
SPU | =l
Solution I |
I™ Tra Solution data files =
Install 14 SPU | |

Install MScript Web Services

If the Maconomy system has already had Touch installed, when installing the FPU, you are
prompted to apply it to the Web server. ClickYes. This action installs the Touch Web service
on the Maconomy Web server, so you do NOT need to do it manually.

If you do not get this message, you need to apply the Web service using MConfig on the
Maconomy Web server manually:

1. On the Web product, select the MScript option.

2. From the (Re)install Deltek Touch framework drop-down list, select the Install
unconditionally option.
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#% MConfig 8.11 - the Maconomy Configurator

Web products on w_17_0.p100.std (local) for w_17_0.sp100.std

‘Web server parameters

Web TPU |tpuNTx86.17_0.p100.t02

CGI parameters

{Refinstall CGI programs [Install on demand

' Java Clent Java Client parameters I
(Rejinstall framework. IInslaII on demand
[Relinstall v.3 framework. IImIaII on demand
V' MSeript (Relinstall Global Packages [Install on demand
(Rejinstall Standard Packages [Ir\s(all on demand
(Rejinstal Web framewark |Imta|| on demand
(Relinstall Deltek Touch framework IIn:IaII on demand
™ Maconomy Mobile TS [Relinstall Maconomy Mobile TS [Install on demand
IV Potal Portal TPU |tpuNTx86.17_0.p100

I Install Portal database in shortnames

I™ Install Portal components in shortnames

(Relinstall Tools framewark. | Install on demand

(Relinstall Application component files IImIaII on demand

Custom Portal files directory |Customlnstaliation

Theme IMaconomy

IV Web Services (Rejinstall Web Services IImRaII on demand

I™ Macanomy Mabile {Relinstall Maconomy Mobile [Install on demand

Extemal web server [P Addiess [ASHAPTI72vS

I~ ifccess ibccess FRU |

(Rejinstall FPU [install on demand

Deltek Support Uses Name |
n

— s [Ea— = B T

Check if the Web services are customized and notify the relevant parties to update the
customizations manually. The Web service is customized if there is a Custom or Solution folder
in MaconomyMScript folder on the Web server. If these folders contain files (for example,
DeltekTouh.l), the person who created the file must be notified to update it manually based on
the changes to the file with the same name in the Standard folder.

Install MaconomyTouch CGI Program

Starting with 1.4, Touch will use MaconomyTouch CGI program, instead of MaconomyMScript.
Switching to MaconomyTouch CGl is necessary for security reasons because it enforces a
default timeout of one hour.

Check your Maconomy Web server if it has already had MaconomyTouch.*.exe and
MaconomyTouch.*.I (in .../cgi-bin/Maconomy).

= If so, the MaconomyTouch CGI program is already installed.

= Otherwise, you can install MaconomyTouch like any CGI program using MConfig. From
the (Re)install CGI programs drop-down list, select the Install unconditionally option.

In using Deltek Touch for Maconomy, make sure that session cookies are disabled. You can set it
in the related MaconomyTouch.| file using the following parameters:

SessionCookies=0

‘ This only applies to Maconomy X1. In 2.0 and higher, it is done automatically.
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Update configuration.ini

Make sure that configuration.ini is using the MaconomyTouch CGI program, instead of
MaconomyMScript, in URL.

The configuration.ini structure has been changed. It contains only the URL (instead of URL,
MSCRIPTNAME and LANGUAGE). Make sure that the URL is containing the full path (for
example, URL="http://myhost:20003/cgi-
bin/Maconomy/MaconomyTouch.wl6de.en_US.exe/Standard/DeltekTouchWS.ms').

Install Dictionaries
This section is optional. It is only needed if you want to localize Deltek Touch.

For translating Touch to Danish, Swedish, Norwegian or Dutch, you have to install the
dictionaries using MConfig. From the (Re)install CGI programs drop-down list, select Install
unconditionally option.

Selecting this option also creates MaconomyTouch.*.exe and MaconomyTouch.*.|.

To install additional dictionaries, select the languages you want to install from the Language
drop-down list.

"{;Mtonﬁg 8.11 - the Maconomy Configurator =] ‘

Web products on w_17_0.p100.std {local) for w_17_0.sp100.std

(Rejinstall Application component files |Ins!a\| on demand

Custom Portal files directory |Customlnstaliation
Theme |M aconomy
IV \web Services  (Rejinstall Web Services |Install on demand
“fmﬂemémstau Macanomy Mabile  [Install on demand

Extemal web server [P Address  [ASHAPTI72vS

I iAccess ihcoess FRU I

[Relinstall FPU [Install on demand

Deltek Support User Name |

I~ Enable IS supportfor ifceess  Connected Coupling Service: [w_17_0_p100.std.csrv
¥ Use HTTPS
I™ | Restart 1IS after enabling
Companies
Languages

I~ Show alllanguages

w17p100.4156 (f_FR, 3 procs, ".w17p100.fr_FR")

w17p100.4157 (da_DK, 3 procs, ".w17p100.da_DK")

w17p100.4158 (de_DE, 3 procs, ".w17p100.de_DE")

w17p100.4159 (en_GB, 3 procs, ".w17p100.en_GB")

w17p100.4160 (es_ES, 3 procs, ".w17p100.es_ES")

w17p100.4161 (LIT, 3 procs, "w17p100it_IT") |

‘WebDaemons w17p100.4154 (en_US, 3 procs, ".w17p100.en_UUS") j

‘wWebDaemon Server [P Address [127.0.0.1 =
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Maconomy RESTful Web Services

This section is optional. It is only needed if you want to use the RESTful Web services in Deltek
Touch.

One of the major changes in Touch 2.1 is that it allows you to use the Maconomy RESTful Web
services in certain functional areas.

Functional Area RESTful Web Services | MScript Web Services
Time Registration X X
Expense Registration X X
Mileage Registration X X
Approvals - X

The main prerequisite for using RESTful Web services is Maconomy 2.2.4 /2.3 GA or later.

If you meet this prerequisite:

= For new installations: Deltek highly recommends that you use RESTful Web
services, wherever possible because of the new functionality is available only on this
Web service The Deltek Touch Installer also recommends that you the use of
RESTful Web services.

For more information, see the Deltek Touch for Maconomy MScript and RESTful Web
Services Comparison Guide.

= For upgrades: Deltek recommends that you use MScript Web services, to start with.
If possible (Maconomy 2.2.4/2.3 GA or later), you can switch to RESTful Web
services after the upgrade. There are other important aspects that you should be
taking into account when deciding which web service you would like to use.

‘ For more information, see the Deltek Touch for Maconomy Upgrade Guide.

Using the RESTful Web Services in Deltek Touch 2.1

Enable RESTful Web Services in Maconomy

The RESTful Web services need to be enabled in the Coupling Service. If this is already the
case, continue with the Proxy Server setup. Otherwise, perform the instructions discussed in this

section.

To enable the RESTful Web services, complete the following steps:

1. Right-click the MConfig executable, select Run as administrator, and follow the prompts
accepting all default values.

2. In the MConfig Main window, double-click the application to open.
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3. Inthe Application Instance window, click OSGi products.

Tandaie (A SPU daty e

B MConfig 8.6 - the Macanamy Configuratar
0OS5Gi server selection

Lo

Servers [17.0cs local] fused by w_17_0) Dmaal
Edi |

|

Dalste |

L: I:encdl.ulnpl Cancel oK. -

 ——
5. Select the Enable RESTful Web Services option.

B s u;vu:-..‘v‘vvi . E,~ Lo

O3Gi products on 17.0¢s focal) for w_17_0

S oy |

W Use Cnging Sree 11 T ™ v
et P N [0 |
i

6. Click OK to save.
7. When the SSL warning displays, click OK to return to the Application Instance window.

8. Click OK to accept the changes and return to the main screen.
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9. Click Next, Next, and Yes to complete the installation.
Proxy Server Setup

Apache

To enable the proxy server in Apache, complete the following steps:
1. Open the “httpd.conf” file.
2. Add the following line of codes:
ProxyRequests Off
ProxyPreserveHost On
3. Add the “ProxyPass” for containers and filedrop REST API, for example:

ProxyPass /containers http://10.1.1.11:1111/containers retry=0
ProxyPass /filedrop http://10.1.1.11:1111/filedrop etry=0

4. Restart the Apache Server.

s

Before you set up the proxy server in IIS, you need to install the Microsoft [IS URL Rewrite 2.0
and install thel Application Request Routing (ARR).

=  For more information on IIS URL Rewrite, see http://www.iis.net/downloads/microsoft/url-
’ rewrite.

For more information on installing the ARR plugin, see http://www.microsoft.com/en-
us/download/details.aspx?id=39715. In IIS 8.0 and 8.5, you need to install the “Web
Platform Installer” before you can install the ARR plugin.

1. Restart [IS Manager.

2. Inthe “Application Request Routing” configuration window, click Server Proxy Settings.
3. Select Enable proxy.

*E Internet Information Services {IIS) Manager

@ © [Gj y PSO-S-C272 N

File  ‘Wiew Help

Q- iz 18 Q;l Application Request Routing

o Erﬂ Start Page

. PS0-5-0222 (PSOlAdministrator) Use thj ture bo configure proxy settings for Application Request Routing,
F'? application Pools ‘ ¥ Enable proxy
3| Sites
B3 Default web Site " a9

9 iaccesshttps HTTP wersion:

bower_components Ipass through j
config
dist ¥ Keep alive

Frameswork.
Time-ouk {seconds):

120

@ w_17_0.pso
133 Server Farms

¥ Reverse rewrite host in response headers

Custom Headers
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To perform the proxy server setup, complete the following steps:

1.

5.

Add the rewrite rules for the proxy in the IS manager. First click the website where you
want to define the rewrite rules.

Deltek recommends that rules must be added to the local site (for example, DeltekTouch)
not to the root site (for example, Default Web Site).

L. 2} Application Pools i
4.[8) Sites ey &) e | " f’ﬂ 1y
n CGI 2 o = i N ks 1=
4@ Default Web Site Kb it .‘L\;_i i—ll (V] =18 Lics i»(g.s 4= /
b (P Customerl sl ,e st Authentic... Cal Compression  Default Directory  Error Pages Failed Handler
b (¥ Customer2 here for containers and Document  Browsing Request Tra... Mappings
@ filedrop ;
p-¥ Customer3 S o= »
= = &) = . =4
p (¥ DeltekTouch ~h ;** o= g £
b @ vivento Output Request  SSL Settings URL Rewrite
b -53. Server Farms Caching Filtering
Management
EN
Configurat... Web
Editor Platfor...

Click the applet “URL Rewrite.”

Add the rules for “containers” REST API for specific client. For more information, see the
Add Rules to “containers” REST API section.

Add the rules for “filedrop” REST API for specific client. For more information, see the
Add Rules to Filedrop API section.

Restart the IIS Manager.

Add Rules to the “containers” REST API

To add the rules to container API, complete the following steps:

1. Open the URL Rewrite applet.
2. Inthe Actions pane, click Add Rule(s).
3. Onthe Add Rule(s) dialog box, select the Blank Rule option in the Inbound rules
section.
Add Rule(s) e T
b
Select a rule template: il
I
. Inbound rules
| | Blank rule (4 Rule with rewrite map
I [ Request blocking
i Inbound and Qutbound Rules
(&% User-friendly URL | Reverse Proxy
Qutbound rules
4| Blank rule
Search Engine Optimization (SEQ)
@ Enforce lowercase URLs izl Canonical domain name
%) Append or remove the trailing slash symbol
Select this template to create a new inbound rule without any preset values. This template opens the "Edit Rule" page that
you can use to define a new rewrite rule for changing the requested URL address. |
0K ‘ | Cancel
4. Click OK.
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5. On the Edit Inbound Rules window, enter or select the appropriate values:
q Edit Inbound Rule

Name:
|‘_w:wnta ners
Match URL A
Requested URL: Using:
Matches the Pattern ;J Wildcards j
Pattern:
Imntainersf"‘ Test pattern... |

v Ignore case

Conditions

\Server Variables

Action

Action type:

IRewrite ¥ I

Action Properties
Rewrite URL:

[http://127.0.0.1:4111/containers/ (R: 1)

W' append query string
™ Log rewritten URL

" sStop processing of subsequent rules

Name — Set the rule name (for example, Containers).

= Regquested URL — Select the Matches the Pattern option.
= Using — Select the Wildcards option.

Pattern — Enter the pattern, for example, /containers/*.

= |gnore case — Select this option.

= Conditions — Do not change anything.

= Server Variables — Do not change anything.

= Action

= Action type — Select the Rewrite option.

= Action Properties

= Rewrite URL — Enter the URL for the RESTful API, for example,
http://10.1.1.111:1111/containers/{R:1}.

= Append query string — Select this option.

= Log rewritten URL — Do not select this option.

Stop processing of subsequent rules — Do not select this option.
6. On the right pane, click Apply.
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Add Rules to the Filedrop API

To add the rules to the filedrop API, complete the following steps:

1.
2.
3.

6.

Open the URL Rewrite applet.
In the Actions pane, click Add Rule(s).

On the Add Rule(s) dialog box, select the Blank Rule option in the Inbound rules
section.

Click OK.
On the Edit Inbound Rules window, enter or select the appropriate values:
= Name — Set the rule name (for example, Filedrop).
= Requested URL - Select the Matches the Pattern option.
= Using — Select the Wildcards option.
= Pattern — Enter the pattern, for example, /filedrop/*.
= |gnore case — Select this option.
= Conditions — Do not change anything.
= Server Variables — Do not change anything.
= Action
= Action type — Select the Rewrite option.
= Action Properties

= Rewrite URL — Enter the URL for the RESTful API, for example,
http://10.1.1.111:1111/filedrop/{R:1}.

= Append query string — Select this option.

= Log rewritten URL — Do not select this option.

= Stop processing of subsequent rules — Do not select this option.
On the right pane, click Apply.

Preserve Host Header

1.

Open a console with Administrative privileges, and navigate to the following folder:
C:\Windows\System32\inetsrv

Enable preserveHostHeader by running the following command:

cd C:\Windows\System32\inetsrv

appcmd.exe set config -section:system.webServer/proxy
/preserveHostHeader:"True" /commit:apphost

Restart the Web server.
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Update configuration.ini

This procedure allows you to update the configuration.ini file.

To update the configuration.ini file, complete the following steps:

1.

Make sure that the [REST_PROXY_DATA] section has the correct information.

For example:

[REST_PROXY_ DATA]

REST HTTP_PROTOCOL="https"

REST DOMAIN NAME="makapt9vs.ads.deltek.com"
REST HTTP_PORT=""

REST CONTAINER NAME="containers"

REST FILEDROP_NAME="filedrop"

REST VERSION="v1"

REST DATABASE="ml9rsl"

REST LANGUAGE="en-US"

REST AUTHENTICATION TYPE="BASICAUTH"

Change the settings in the [REST_MODULE_SETUP] section according to your need:

= Set USERESTFORTIME="true" if you want to use the RESTful Web services for time
registration

= Set USERESTFOREXPENSE="true" if you want to use the RESTful Web services
for expense and mileage registration

= |tis mandatory to keep USERESTFORAPPROVALS="false" because Deltek Touch
2.0 does not support RESTful Web services in approvals.

configuration.ini

The configuration.ini is a setting file utilized by Deltek Touch 2.0 to provide environment
information to the Touch application. The new parameters in configuration.ini are used to support
the new Maconomy RESTful API while still supporting the existing MScript technology.
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; Maconomy Touch Configuration File
H R R R R R R R R R R R R R R R R R R R R R

[SERVER_DATA]

URL="http://10.1.31.,1131:13111/cgi-bin/Maconomy/HMaconomyTouch.wl90pl00.en US.exe/Standard/DeltekTouchWS.ms"

CHARSET="UTF-8"
DYNAMICSCRIFT="falze"
DEBUGGERFL="falzse™
TOUCHSERVERVER="2.0.0.0"

HELPDOCURL="http://clientsite.deltek.com/deltektouchdownloads/docs/DeltekMaconomyTouchTimeUserGuide. pdE"

CLIENTURL="https://clientsite.deltek.com/20 23Rest"

[REST_PROXY DATA]
REST_HTTP_PROTCCOL="http"
REST_DOMAIN NAME="]ocalhost"
REST_HTTP_PORT=""
REST_PROXYPASS_CLIENT_CODE="genantcode"
REST_CONTRINER NAME="containers"
REST_FILEDROP NAME="filedrop"
REST_WVERSICN="w1"
REST_DATABASE="wl1S0plOQ"
REST_LANGUAGE="en-US"
REST_IIS TOUCH FOLDER NAME=""
REST_AUTHENTICATION TYPE="BASICAUTH"

[REST_MODULE_SETUP]
USERESTFORTIME="trus"
USERESTFOREXPENSE="trus"
USERESTFORAPPROVALS="false"

Existing Parameters

khkrkhkkhkhhkhkhkhkhkhkhkhkkrhkkhkhkhkkhkrkkhkkhkkhkxkkx

;  Maconomy Touch Configuration File
*hkhkhkhkhkkhkhkhkhkrkhkhkhhkhkhkrkhkhkhkhhhhhkhkkkkk

[SERVER_DATA]

URL=""

CHARSET=""

DYNAMICSCRIPT=""

DEBUGGERFL=""

TOUCHSERVERVER=""

HELPDOCURL = “”

CLIENTURL=""

New Parameters

In Deltek Touch 2.0, the following parameters have been added to support the Maconomy

RESTful Web service and multi-tenantsetup.

The new parameters are divided into two sections: REST_PROXY_DATA (which contains
connection details parameters) and REST_MODULE_SETUP (contains parameters responsible
for enabling the REST functionality in the time, expense, and approvals modules).

[REST PROXY DATA]

REST HTTP_ PROTOCOL=""

REST DOMAIN NAME=""
REST HTTP PORT=""

REST PROXYPASS CLIENT CODE=""
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REST CONTAINER NAME=""

REST FILEDROP NAME=""

REST VERSION=""

REST DATABASE=""

REST LANGUAGE=""

REST IIS TOUCH FOLDER NAME=""
REST AUTHENTICATION TYPE=""

[REST MODULE SETUP]
USERESTFORTIME=""
USERESTFOREXPENSE=""
USERESTFORAPPROVALS=""

Description of the New Parameters
REST_PROXY_DATA

=

REST_HTTP_PROTOCOL - This parameter is set by the Touch Installer to "https." It
represents the protocol (HTTP/HTTPS) used on the REST requests initiated from the
Touch client. You can change it in the configuration.ini to "http," if you are in an early
phase of the Touch installation and you do not have an SSL certificate yet. However,
you can test Deltek Touch only using the Web application. Before you complete the
Deltek Touch installation, you must have this parameter set to "https," else the Touch
native apps will not work.

REST_DOMAIN_NAME - This is the host name of the Touch Server. It refers to the
computer name or the IP address of the Touch Server.

REST_HTTP_PORT - This is the associated port number. If the REST Web service
is running in a secured layer, it should be in 443. Otherwise, leave this field blank or
set it to the appropriate value.

REST_PROXYPASS_CLIENT_CODE- Enter a value if there are multiple proxy
setup in the Touch Server. The value that you can set from this parameter is derived
from the Web site name of Touch. For example, http://clientsite.com/Customerl,
which means the value of this parameter is “Customer1”. Typically, this is a distinct
way of accessing the REST proxy server setup in the Web server.

REST_CONTAINER_NAME — Enter containers.

REST_FILEDROP_NAME - Enter filedrop.

REST_VERSION — Enter v1.

REST_DATABASE — This is the database name of the RESTful Web service.

REST_LANGUAGE - This is the locale code. Typically, this parameter is the same
value as the language being set up for Mscript.

REST_IIS_TOUCH_FOLDER_NAME - This is only used if the Deltek Touch is
hosted using 1IS and the rewrite rules to access the REST API have not been
configured in the root or Default Web site.

_} Application Pools

- @ Sites

4 &3 Default Web Site
aspnet_chent
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To determine if the rewrite rules have been configured in the root Web site, you need to

open the IIS URL Rewrite.

L} Application Pools
4@l Sites
4G Default Web Site
b F Customerl
b #® Customer?
v F Customerd
4 DeltekTouch
b -l docs
p- Logs
b Maconormy
4 i vivento
P Time
-l architecture
| archive
| cordova-s-src
deltas
locales
| maconomyshared
| plugins
| resources
1 seripts
b -89 Server Farms

£
Ac4

G
Default
Document

=]

=

Madules

)
Directory
Browsing

Cutput
Caching

|
2
Compression Ervor Pages

%

ISAPI Filters

=
-—

b

Lagging

=

MIME Types Request

Filtering
Management

0

Web
Platfer...

4

Configurat...
Editor

T T T T T

How to set the value of REST_IIS_TOUCH_FOLDER_NAME?

Request Tra...

Failed Handler

Mappings

+
Q | =
9

S5L Settings  URL Rewrite

If the rewrite rules for accessing the REST_API have not been placed in the root Web
site, set the value of this parameter using the name of the Web site where the rewrite

rules were configured.

..:‘ Application Pools Inbound rules that are applied to the requested URL address:

HTTP
Respon.

4. [@| Sites
a2 Default Web Site
b Customerl
¥ Customer2

Mame Input Match

b
]
4 ¥ DeltekTouch

-l docs

p-[] Logs

[ Maconarmy
a2 vivento

¥ Time

]
4
0
¥ Customer3 4
¥
f

€ ]
Fl

Pattern

3 architecture

| archive Outbound rules that are applied to the headers or the content of an HTTP response:

| cordova-js-src

| deltas

| locales
maconomyshared

| plugins

| resources

| Mame Input Match Pattern

b
b
b
b
3
b
2
2

scripts
-85 Server Farms

Action Type

For example, in the screenshot, the rewrite rules are in the Deltek Touch web site. In the

Input column, the URL path after ‘/DeltekTouch/ value displays. In this case,
DeltekTouch as the value for the parameter.

REST_MODULE_SETUP

USERESTFORTIME - Valid values are true or false. True means the time
registration functionality uses the REST API. False means it uses MScript.

use

REST_AUTHENTICATION_TYPE — The value for this parameter is “BASICAUTH.”

USERESTFOREXPENSE - Valid values are true or false. True means the expense

and mileage sheet functionality uses the REST API. False means it uses MScript.

USERESTFOREXEPENSE — Deltek Touch 2.0 must use the false value.
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Server Side Configuration Settings

This section is optional. You can modify the following configuration options that are included in
the MaconomyMScript\Standard\DeltekTouch.l.

Valid Options | Default Description
Value
Submit Daily, Weekly | Weekly This option specifies whether you
register and submit time on a daily or
weekly basis.
searchMaxRowcount | 0-100 30 This is used to restrict the number of

rows that a search returns.

searchtext Search Search This option is NOT used in this
release.
debug true or false False This does not apply to REST.

This options works in Touch 1.x, and
MScript Touch 2.0. If you set debug =
true, it logs some of the error
messages occurring when using the
MScript Web service.

IncrementalMinutes Minutes Empty This option controls the increment
used in the hour picker. If empty, it
usse the Registration Unit user
settings specified on the Settings
screen of Touch. The Registration
Unit user setting has priority over the
IncrementalMinutes server setting.
This server setting is usefull to set the
default increment for all users, but
users have the option to overwrite this
in the user setting.

For example: if IncrementalMinutes is
set to 15, you can enter hours like
1:00, 1:15, 1:30, 1:45 in the
application.

IncrementalDays Real Empty This option controls the increment
used in the day picker. If empty, it
uses the Registration Unit user
settings specified on the Settings
screen of Touch. The Registration
Unit user setting has priority over the
IncrementalDays server setting. This
server setting is usefull to set the
default increment for all users, but
users have the option to overwrite this
in the user setting.

For example: if IncrementalDays is
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Valid Options

Default
Value

Description

set to 0.15, you can enter days like
0, 0.15, 0.30, 0.45, 0.60in
the application.

UseExternalCredenti | true or false

als

False

This option controls whether you use
external credentials (Kerberos or
Azure). If you would like to be able to
log on to Touch Time using your
domain/network/Azure credentials,
and Maconomy is set up to support it,
then please set this option to true.

Kerberos or
Azure

ExternalCredentialsT
ype

Kerberos

Specifies what kind of external
credentials we support in Deltek
Touch. Considered only if
UseExternalCredentials = true, else
the setting is ignored.

Specifies which charset should be
used for the external login credentials
(user name, password, and domain
when using Kerberos SSO).

If you experience issues with Danish
characters in domain password, try
changing it to iso0-8859-1.

UTF-8
1ISO-8859-1

ExternalCredentialsC
harset

UTF-8

Specifies which charset should be
used for the external login credentials
(user name, password, and domain
when using Kerberos SSO).

If you experience issues with Danish
characters in domain password, try
changing it to is0-8859-1

AzureNativeClientID | String

Empty

This setting is relevant only for Azure.

Represents the ClientID of the Azure
native application, to be used by the
Deltek Touch native application.

AzureRedirectURI String

Empty

This setting is relevant only for Azure.

Represents the Redirect URI of the
Azure native application to be used by
the Deltek Touch native application.

ShowMissingTimesh | true or false

eetsDue

True

This does not apply to REST.

This option controls the status of
missing (not created before the
current date) daily timesheets. If true,
the status is Due, else the status is
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Valid Options

Default

Value

Description

New.

WeekStart

0 (Sunday),
1(Monday),
2(Tuesday)
3(Wednesday)
4(Thursday)
5(Friday)
6(Saturday)

This option controls which day
displays as the first day in the
Calendar. It can be overwritten by the
“Week Start” user setting. The server
setting is only the default value for the
user setting.

MandatoryRejection
Remark

true or false

True

This option is available only in
Maconomy 2.1.1 and higher.

This option controls if you have to
specify a rejection comment when
rejecting a time sheet.

= Iftrue, you must specify a
rejection comment, else you
cannot reject.

= |If false, the rejection comment is
optional.

CustomSbmitTimesh
eetAction

String

Empty
string

This does not apply to REST.

The name of the custom action used
for submitting time sheets, if any

ShowOnlyPOLinesT
OApprove

true or false

True

This option is available only in
Maconomy 2.1.1 and higher.

When approving purchase order lines,
you see the entire purchase order.

This setting controls which of the lines
you want to see when approving PO
lines

= |f true (default), it only displays
PO lines you can approve.

= |If false, it displays all PO lines in
the given PO, including the lines
you can approve.

ShowOnlylnvoiceAll
ocationLinesToAppr
ove

true or false

True

This option is available only in
Maconomy 2.1.1 and higher.

When approving invoice allocation
lines, you see the vendor invoice and
its allocation.

This setting controls which of the lines
you want to see when approving
invoice allocation lines.
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Valid Options | Default Description

Value

= If true (default), it only displays
invoice allocation lines you can
approve.

= |f false, it only displays all invoice
allocation lines for the given
vendor invoice, including the
lines you can approve.

NotificationRecalcul | Integer 1800 This option is available only in
ationinterval Maconomy 2.1.1 and higher.

This setting controls the frequency (in
seconds) of recalculating the
notification (approval and
rejected time)counters inthe
background.

= For disabling the background
recalculation, use -1.

=  Setting under 5 min (300 sec)
may lead to performance
penalties on the Maconomy
server.

CopyRemarkFromTi | true or false False This option is available only in
meSheetLineToFavo Maconomy 2.0 and higher.
rite

This setting controls if the Remark
field should be copied from the time
sheet line to the favorite when
creating a new favorite based on a
time sheet line

If true, the Remark field value is
copied from the timesheet line into the
favorite (which is creaed from the time
sheet line)

If false, the Remark field value is
NOT copied from the timesheet line
into the favorite (which is creaed from
the time sheet line)

ExpenseAttachment | string “header This option is available only in
Type and line” Maconomy 2.0 and higher.

This setting controls where can you
attach receipts to expenses. It can
have one of the following values:

= "none" = This value indicates
that it is not possible to attach
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Valid Options

Default
Value

Description

receipts to expenses at all.

= "header" = This value indicates
that it is possible to attach
receipts only to the expense
sheet header.

= "line" = This value indicates that
it is possible to attach receipts
only to the expense sheet line.

= "header and line" = This value
indicates that it is possible to
attach receipts to both the
expense sheet header and line.

nTimeSheets

ShowJobsWithEmpl | true or false False This option is available only in
oyeeControl Maconomy 2.0 and higher.
It allows you to see the employee's
jobs (based on Employee Control) on
the Find Job screen when creating a
time sheet line using a job
= [f true, the All tab displays the
Recently used projects and My
Job list (jobs the user has
access to via Employee Control)
= |[f false, the All tab displays the
Recently used projects only
list.
ShowZeroHourJobsl | true or false True This option is available in all
nSummary supported Maconomy versions.
It controls the Summary screen, Job
tab content.

o If true (default): the time
sheet summary will show all
job/task/activity combinations,
used in the selected weekly
time sheet

o If false: the time sheet
summary will show only
job/task/activity combinations,
used in the selected weekly
time sheet, which are having
hours registered

AllowNegativeHoursl | true or false false This option is available in all

supported Maconomy versions.

Determines if you are allowed to enter
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Default
Value

Description

negative hours on time sheet lines in
Timesheet and Timesheet Line
screens

e |If true: you are allowed to
enter both positive and
negative hours on time sheet
lines

o |[f false (default): you are
allowed to enter only positive
hours on time sheet lines

AllowNegativeDaysIn
TimeSheets

True or false

false

This option is available to all
supported Maconomy versions.

Determines if you are allowed to enter
negative days on timesheet lines on
the Timesheet and Timesheet Line
screens

= If this is set to true, you are
allowed to enter both positive
and negative days on timesheet
lines.

= |[f false (default), you are allowed
to enter only positive days on
timesheet lines.

ShowExpense

true or false

True

This option is available only to
Maconomy 2.0 and higher.

To disable expense functionality for
all users, set ShowExpense to false.

ShowMileage

true or false

True

This option is available only to
Maconomy 2.0 and higher.

To disable mileage functionality for all
users, set ShowMileage to false.

MaxAttachmentFileSi
ze

Integer

1000

Determines the maximum file size (in
KB) of the pictures attached to
expense sheets in Deltek Touch.

DeltekTouch.I file in the MaconomyMScript\Standard folder and place it in the

‘ Before you change any of these settings, Deltek recommends that you make a copy of the

MaconomyMScript\Custom folder. Then, change the file in the Custom folder instead of the

original file.
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For mor information about customization, see Deltek Touch for Maconomy Layout Configuration
‘ Guide.
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Touch with Azure Setup
The Azure support is available only to Maconomy 2.4 LA or higher.

If Maconomy is set up with Azure and you prefer your Deltek Touch installation to use Azure, you
need to complete additional setup.

documentation. Prior to enabling the Azure setup in Deltek Touch, Deltek recommends to test

‘ It is a prequsite that Azure is set up for Maconomy as described in the Maconomy
Azure in Workspace Client.

For more information, see the Deltek Maconomy Azure SSO Guide.

Register an Azure Native Application for Touch Native Application

To register an application for Touch, complete the following steps:
1. Open the Azure Active Directory (AAD) in the Azure management portal.
2. Click the Applications tab.

3. On the Applications tab, click Add, and select the Add an application my organization
is developing option.

4. In the following two forms, enter Maconomy Touch as name, select Native Client
Application as type, and enter https://deltekmaconomyclient for the REDIRECT
URI.

’ This will be the AzureRedirectURI.

5. Under the properties section of the newly created application, find the read-only field
labeled Client ID and note its value. This is the Touch Client ID.

‘ This will be the AzureNativeClientID.

properties

NAME touchapp

CLIENT ID 347bbdod-15da-4564-b58f-1dfcadc7e2bf
REDIRECT URIS https://deltekmaconomyclient

6. Set the permissions on the application to give access to the Maconomy Server Azure
application.
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permissions to other applications

celd7c97-f4b3-4cbl-918b-fae064df647b

Delegated Permissions: O

Maconomy Server

indows Azure Active Directory

Delegated Permissions: 1

Access Maconomy Server

Update the Maconomy Azure Application to Support the Deltek Touch Web
Application

The Deltek Touch Web application uses the same Azure application as the Workspace Client. If
you follow the Maconomy documentation for Azure, this Azure Web app is called Maconomy.

To make sure that Deltek Touch can use the Maconomy Azure application, add the Touch URL to
the Reply URL on the Azure application.

To add the Touch URL to the Reply URL, complete the following steps:

1.
2.
3.

Open AAD in the Azure management portal.

Click the Applications tab.

On the Applications tab, find Maconomy application.

maconomy

€23 DASHBOARD  USERS  CONFIGURE ~ OWNERS
properties

NAME Maconomy

Add the relevant Touch URL (for example,

https://makapt9vs.ads.deltek.com/21 Mrpl01Rest/maconomyshared/backend/oauth2tok

enreturn.php) to the Reply URL.

REPLY URL

https://10.4.9.124:4433/cgi-bin/Maconomy/MaconomyPortal x.

https://10.4.9.124:4433/cgi-bin/Maconomy/MaconomyPortal.x;

https://makapt27vs.ads.deltek.com/DeltekTouch/2100/MRP101

| | https://makaptdvs.ads.deltek.com/21_Mrpl01Rest/m aconomy&{ x |

https://10.4.8.243:4433/cgi-bin/Maconomy/MaconomyPortal.m

https://10.4.8.243:4433/cgi-bin/Maconomy/MaconomyPortal.m

https://makQEtest.onmicrosoft.com/maconomy

https://makaptdvs.ads.deltek.com

https://login.microsoftenline.com/common/oauthZ/nativeclien

http://localhost:8888/deltektouchl.3/maconomy,/time/macono
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Turn On Azure Login in the Web Service

The following changes are needed in the custom DeltekTouch.I file:

1.
2.
3.

Set UseExternalCredentials: true. By default, it is set to false.
Set ExternalCredentialsType: #K”Azure”. By default, it is empty

Set AzureNativeClientID to the Touch Client ID (step 5 of the Register an Azure Native
Application for Touch Native Application procedure). By default, it is empty.

Example:
AzureNativeClientID: #K"347bbd9d-15da-4564-b58f-1dfcadc7e2bf"

Set AzureRedirectURI to the REDIRECT URI (step 4 of the Register an Azure Native
Application for Touch Native Application procedure). By default, it is empty.

Example:
AzureRedirectURI: #K"https://deltekmaconomyclient"

Touch with Single Sign-On Setup

If Maconomy is set up with Kerberos SSO and you prefer Touch to use SSO, you need to
perform the following tasks:

When Touch is using SSO, Unicode characters are not allowed in the domain user name and/or
password..

In DeltekTouch.l, set useExternalCredentials=true. By default, it is set to false.

Copy KerberosSSOClientLib folder and KerberosSSOClIient.jar file from the related TPU
to cgi-bin/Maconomy.

Make sure that Java is installed on the Maconomy Web server, since during Single Sign-
On, Deltek Touch executes Java code on the Maconomy Web server. This Java should
be the same as the Java embedded in your Maconomy product (delivered as part of
TPU); otherwise, there is a risk that newer Java versions are not certified for the
Kerberos SSO used by Maconomy.

Make sure there are is only one Java version installed on the machine
Add the Java path to environment variables on the machine.

In some cases you need to run some applications as administrator (for example,
MaconomyMscript.exe, Run as Administrator).

Deltek Touch uses the Kerberos Java client for getting the Kerberos ticket while other
Maconomy clients (Workspace Client, Java Client, Portal) are using the native API for the
same purpose. Therefore, even if SSO works properly in other Maconomy clients
(Workspace Client, Java Client, Portal), there is no guaranty that it works in Deltek Touch
as well. You may need additional steps for making the Touch SSO work.

One possible difference is that, for Deltek Touch, the TSG request sent by the Maconomy
Web server to the domain controller uses UDP instead of TCP. Since UDP is not as
reliable as TCP, in case of bigger requests, this could lead to segmented packages,
which may be dropped by the network. This leads to a situation when the request just
hangs, the domain controller does not send back a response to the Maconomy Web
server, and thereby causing an unsuccessful domain (SSO) login in Deltek Touch. If this
is your case, you need to force the usage of TCP by creating a custom Kerberos
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configuration file (krb5.local.conf), as a copy of the standard Kerberos configuration file
(krb5.conf) with one additional line: udp_preference_limit = 1.

For example:
‘ =  C:\maconomy\webserver\w_15_0.sp2\MaconomyMScript\Custom\DeltekTouch.l

(useExternalCredentials=true)

= Copy KerberosSSOClIientLib folder and KerberosSSOClient.jar from
C:\maconomy\tpu.NTx86.15 0.p2b6.dir\bin to
C:\maconomy\webserver\w_15_0.sp2\cgi-bin\Maconomy

= Install Java 7

=  Add C:\Program Files (x86)\Java\jre6\bin to Path in Environment Variables

Debug Touch Single Sing-On

If you need to debug Touch SSO, complete the following steps:
1. Make sure that SSO works in Java client and Portal.

2. Check the Web server error logs (for example, C:\Program Files (x86)\Apache Software
Foundation\Apache2.2\logs\error.txt).
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Appendix A: Localization

Starting with Touch 1.2.3, you can translate Deltek Touch for Maconomy to other languages.
Everything in Deltek Touch for Maconomy is translated using the dictionaries in Maconomy core
product.

By default, Deltek Touch for Maconomy 2.1, 2.2, and 2.3 come in the following languages:

= English

= Danish

= Swedish

=  Norwegian
= Dutch

=  French

= German

= |talian

=  Spanish

= Portuguese

Deltek Touch for Maconomy X1 and 2.0 come in the following languages:

= English

= Danish

=  Swedish

= Norwegian
= Dutch

= French

= German

= Spanish

When you install FPU 1.2.3 or higher, you get the translations automatically through the standard
dictionaries installed on the Maconomy server. After this, you need to set “(Re)install CGI
programs” to “Install unconditionally”, in MConfig if you want to apply the dictionaries to the Web
server, and thereby making the translations available in Deltek Touch for Maconomy.

If you need Deltek Touch for Maconomy in a different language, you need to create your own
dictionary and apply it.

For example, you would like to translate Deltek Touch for Maconomy to French. Assuming that
you already have a French dictionary, you need to add the Touch translations to it:

1. InTranslations.<shortname>.DK search for “{Touch}”. This actions gives you the list of
terms to be translated.

2. You must translate all strings postfixed with {Touch} and add the translations to your
French dictionary. For example,

Yes{Touch} Oui
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Appenix B: Touch Server URL in Email

Logging on for the first time no longer requires users to enter the complete URL of the Touch
Server. You now send them an email message containing a link that either directs them to the
appropriate app store (if Deltek Touch is not yet installed) or populates the Touch Server URL
field with their company URL.

ProductApplication.php

The Touch Server has been updated with the ProdcuctApplication.php file that performs the
linking and passes the Touch Server URL value to the application or redirects you to the
appropriate app store.

Link for Customers

The link that you send to users is a hyperlink. When users click the hyperlink, the following
scenarios occur:

1. If Deltek Touch is not installed, it takes them to the appropriate app store to download the
application.

a) Users then download the application from the app store.
b) They click the link again (and proceed to step 2).

2. If the application is installed, it populates the Touch Server URL field with their company
URL.

3. They tap the Connect button to connect to the Touch Server.

How to Create the Link to Email Users

Each application may have specific steps required to create a hyperlink. This section describes
the steps that apply to Microsoft Outlook. For other applications, see the documentation on
creating a hyperlink.

1. Use the following format for the hyperlink:

https://<yourdomain
>/deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php

2. Replace <yourdomain> with the company’s domain information. The domain must be
externally accessible to devices on the Internet. The following part of the hyperlink,
however, is fixed:

deltektouch/maconomy/time/maconomyshared/backend/maconomytimeurl.php

If Deltek Touch is being hosted in a multitenant environment, you need to append a set of
strings to the link you will be sending to users. Typically, it is the Web site directory name
(for example, deltektouch). For example, in the URL below, you should append
“deltektouch”:

https://<yourdomain>/deltektouch/maconomy/time/maconomyshared/backend/mac
onomytimeurl.php?custcd=deltektouch

3. Create the instructional text in the email message where you will embed the link.
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4. Highlight the word “here,” right-click, and select Hyperlink from the menu (alternatively,
click the Insert tab, and click the Hyperlink button).

5. Paste the hyperlink into the Address field of the dialog box, and click OK.

For Example:

Click here to initialize your Touch application with the proper URL to access the Touch Server. If
you have not installed the application, clicking the link will take you to the appropriate app store
to install the application. Once you've installed the application, clicking the link will properly
initialize the URL in your application. Should you not be able to click the link, you can copy and
paste the following into your default device browser:

https://yourdomain.com/deltektouch/maconomy/time/maconomyshared/backend/maconomytime
url.php

When users receive the email, click the link , and the application is installed, the following screen
displays.
Carrier & 2:23 PM L

Connect

Delte Know more.
Do more.™
Server URL

://vistouch.deItek.comfdeltektouch/maconomyftimel
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Appendix C: Logging Capability

If you want to gather some statistics about your Deltek Touch users and their usage pattern,
enable logging on the Maconomy MScript based Web service.

Enabling logging always cause some performance overhead. If you use, however, the options
recommended in this section, this overhead becomes unnoticeable.

How to Enable Logging?

To turn on logging, you need to change the setup file for the MaconomyTouch CGI program.

To change the change the setup file, complete the following steps:
1. Inthe Maconomy Web server, locate the /cgi-bin/Maconomy folder

2. Find the CGI program used by Deltek Touch by checking the URL in the configuration.ini
file on the Touch Server. In most cases, the CGI program should be
MaconomyTouch.*.exe.

3. Find the setup file for the CGI program. If the CGI program is MaconomyTouch.*.exe,
then the setup file is MaconomyTouch.*.I.

4. Add the Log parameter.

Where is the Log File?

By default, the log file can be found in the same place as your CGI program and its setup file,
which is in the /cgi-bin/Maconomy folder.

The file name is the same as the CGI program name: MaconomyTouch.*.log. You can open the
log file in any text editor.

How to Determine Who are Using Deltek Touch?

If you want to know who are using Deltek Touch and how often they use it, the recommended
setting is as follows:

Log = login

As a result, the log file includes all Deltek Touch logins and the corresponding user names.

Example

[2015-11-25 11:48:28.171] [PID = 000185761 )
[/Standard/DeltekTouchWS.ms] [I286yaavF1l] [3135] [192.168.43.102]
[Administrator] maconomy::login ("Administrator™) (7 elapsed msec.

[2015-11-25 11:49:15.749] [PID = 000027441 )
[/Standard/DeltekTouchWS.ms] [MNW33zWfr4] [32138] [192.168.43.102]
[Administrator] maconomy::login ("Administrator") (10 elapsed msec.

[2015-11-25 11:54:59.823] [PID = 00018476] )
[/Standard/DeltekTouchWS.ms] [JDN9ASv]iG2] [20598] [192.168.43.102]
[Anders Hansen] maconomy::login ("Anders Hansen") (19 elapsed msec.
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If you want the total number or none-unique logins, count the lines. You could conduct more
elaborated analysis, by example, in Excel.
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Appendix D: If You Need Assistance

If you need assistance installing, implementing, or using Deltek Touch for Maconomy, Deltek
makes a wealth of information and expertise readily available to you.

Customer Services

For over 30 years, Deltek has maintained close relationships with client firms, helping with their
problems, listening to their needs, and getting to know their individual business environments. A
full range of customer services has grown out of this close contact, including the following:

=  Extensive self-support options through the Customer Care Connect Web portal.
=  Phone and email support from Customer Care analysts

= Technical services

= Consulting services

= Custom programming

= Classroom, on-site, and Web-based training

Find out more about these and other services from the Customer Care Connect site.

Customer Care Connect Site

The Deltek Customer Care Connect site is a support Web site for Deltek customers who
purchase an Ongoing Support Plan (OSP).

The following are some of the many options that the Customer Care Connect site provides:

=  Search for product documentation, such as release notes, install guides, technical
information, online help topics, and white papers

= Ask questions, exchange ideas, and share knowledge with other Deltek customers
through the Deltek Connect Customer Forums

= Access Cloud specific documents and forums

= Download the latest versions of your Deltek products

= Search Deltek’s knowledge base

=  Submit a support case and check on its progress

= Transfer requested files to a Customer Care analyst

=  Subscribe to Deltek communications about your products and services
= Receive alerts of new Deltek releases and hot fixes

= Use Quick Chat to submit a question to a Customer Care analyst online

For more information regarding Deltek Customer Care Connect, refer to the online help available
from the Web site.
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Access Customer Care Connect

To access the Customer Care Connect site, complete the following steps:

1. Go to http://support.deltek.com.

2. Enter your Customer Care Connect Username and Password.

3. Click Log In.

firm’s Deltek Touch for Maconomy Administrator.

‘ If you do not have a username and password for the Customer Care Connect site, contact your

If you forget your username or password, you can click the Account Assistance button on the

login screen for help.

Additional Documentation

The following table lists the additional Deltek documentation available for this release. Except
where noted, all the user guides and quick reference guides listed in this table are available for
download from the Deltek Customer Care Connect site.

Document Name Description

Deltek Touch for Maconomy User Guide

This document contains detailed information
and instructions on how to use various
features of the application.

Deltek Touch for Maconomy Release Notes

This document contains a summary of the
technical considerations, major features, and
known issues of the application.

Deltek Touch for Maconomy Upgrade Guide

This document is only intended for Technical
Consultants. It describes necessary steps to
upgrade to the latest Touch system.

Deltek FPU Release Notes for Maconomy
Touch

These documents are only intended for
Technical Consultants.

The document names vary depending on the
supported Maconomy version. Each document
contains a summary of the pre-installation
information, enhancements, and API changes
to Touch for each supported Maconomy
version. It is part of the Deltek Touch for
Maconomy 1.4 product information suite and
should only distributed internally within the
Maconomy organization and to partners.

Deltek Touch for Maconomy Layout
Customization Guide

This document is only intended for Technical
Consultants. It describes tasks necessary for
the customization of layouts of the Deltek
Touch for Maconomy application.

Deltek Touch for Maconomy MScript and

This document describes the differences
between MScript and Representational State
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Document Name Description

REST Web Services Comparison Guide Transfer (REST) Web services to help
technical consultants prepare for implementing
Deltek Touch for new users or migrate their
current Touch installation to REST.
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